
 

Getting Started with CSS Sculptor 3 
With CSS Sculptor, you can quickly create a cross-browser compatible layout 
with custom widths, margins, padding, background images and more. 
Additionally, you can use CSS Sculptor 3 to add Spry components such as 
Spry collapsible panels, Spry tabbed panels, and Spry accordion panels. 

This Getting Started Guide will show you the most commonly used steps for 
using CSS Sculptor to create your design. 

Installing your extension 

The first step to getting started with your purchase is to install your 
extension. All WebAssist Dreamweaver extensions are installed through the 
Adobe Extension Manager. 

Follow the instructions found in the following two TechNotes for downloading 
and installing the extension. 

• Downloading extensions and files 

• Installing WebAssist extensions 

 

What Do You Need to Start?  

• Dreamweaver CS3 or CS4  

• Eric Meyer’s CSS Sculptor 3 

 

Do you have a Dreamweaver site defined? 

The first step in developing websites in Dreamweaver is to define a site. This 
helps you easily access your files from the Dreamweaver Files panel, ensures 
that templates and links are correct, and makes uploading to your testing 
server or live site easy. 

If you haven’t yet defined a site in Dreamweaver, review the Dreamweaver 
Simulation available from the Getting Started with Dreamweaver     tutorials. 

 

 

http://www.webassist.com/go/technotes/download
http://www.webassist.com/go/technotes/install
http://www.webassist.com/go/gsg/dw_sims/


Getting Started 

Other than defining your site in Dreamweaver, CSS Sculptor does not have 
any additional requirements for you to be able to load the interface. 

Open CSS Sculptor 

1. From the Insert menu choose WebAssist > CSS Sculptor… 

The CSS Sculptor Quick Insert interface will display. This interface provides 
access to each area of CSS Sculptor for creating a completely customized 
CSS design. 

 

Working with preset designs 

CSS Sculptor includes a number of preset layout designs for you to use.  
Each option is provided to give you a starting point for creating the layout 
you desire. 

To speed up your production, choose the layout that best matches the 
design you are aiming to achieve. Then, customize it to look however 

you would like. 

1. From the design type menu, choose a desired preset. 

2. From the design menu, choose the design that best matches the color 
scheme you intend to create. 

Note: Refer to the preview area to ensure you have chosen a desired that 
suits your needs. 

3. To further customize this design, choose the Customize CSS or 
Manage Colors buttons. 
More details on using each of these options is detailed below. 
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Customizing the CSS 

The Customize CSS interface allows you to completely modify all aspects of 
your site’s layout and design.  To easily access the features you wish to 
customize, the interface has been separated into the following 6 tabs. 

• Layout: Provides options for modifying the overall layout. 

• Box: Provides options for adding new divs, spry components, as well 
as apply widths, margins and padding. 

• Type: Allows for customizing the various text included in your layout.  

• Design: Includes options for applying color, background image and 
borders to each individual element. 

• Print: Allows for configuring a print style sheet to be included with 
your CSS. 
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Layout tab 

The Layout tab provides various options for designing your overall layout. If 
you selected a preset from the Quick Insert interface, all the various options 
will be pre-populated based on that option. 

The following introduces the various sections of the interface that you can 
adjust, if desired. 

1. From the Page Structure section, choose a design width, and position. 

2. If desired, choose the Maintain overall column width or Equal column 
lengths options. 

Maintain overall column width – This will ensure that the column 
widths are the same, regardless of changes to the margin or padding. 

Equal column lengths - This applies the faux column technique by 
taking a screenshot of the bottom portion of the design, and repeating 
this image in the contentwrapper div of the design. This image is 
inserted into your defined site. 

Note: In order to apply either of these techniques, you need to use a 
fixed column layout where everything uses the same unit of 
measurement.  You may need to move to the Box tab to modify the 
margin or padding for some of your div elements. 

3. Under Layout Components, choose whether you wish to include a 
Header, Top navigation, Content area or footer. 

4. If desired, choose the type of header and footer you wish to use. 

Header – Choose from normal or full width headers. 

Footer – Choose from normal, full width, fixed normal, and fixed full 
width. 

5. Add any desired left or right columns by entering the appropriate 
number in the text field. 

Note: Some of these options may already be populated based on the 
chosen preset. 

6. Click Apply to update the Preview to see your changes. 

7. When ready, proceed to the Box to make further modifications. 

Page 4 of 12 



Box tab 

The Box tab in CSS Sculptor 3 allows you to add or customize various box-
related properties (like margins and padding) for each layout component.  
Additionally, you can add Spry components for even more advanced custom 
layout creation. 

The Layout Component tree displays all the various elements currently used 
in your design.  Using this tree, you can select a component to customize 
and move a component up, down, left or right throughout the CSS 

The following describes the most common components that you may see in 
the Layout Component tree. 

• body – The body tag is at the top of the layout tree and is made 
available to change margins and padding in the Box tab; in other tabs, 
select the body entry to specify a different overall font-family, text 
color or background color. 

• outerWrapper – The outerWrapper encompasses all of the <div> 
tags used to construct the page. A common use of the outerWrapper is 
to center the layout by setting the left and right margins to auto.  

• contentWrapper – As the name implies, the contentWrapper 
surrounds the main content area, including any columns. Select the 
contentWrapper when you want to modify properties for both content 
and column(s). 

1. From the layout tree, choose the component you wish to modify. 

2. For the selected component, enter a width, height, and apply a float if 
desired. 

3. Note: Click Apply regularly after making adjustments to ensure that 
your changes are applied as desired. 

4. If desired, enter margins and padding for the selected component. 

5. Select other components to make additional modifications. 
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Add additional components to your layout 

CSS Sculptor 3 allows you to add the following new components to your 
design. 

• New div elements 
• Spry accordion panels 
• Spry collapsible panels 
• Spry tabbed panels 

6. Choose the element you wish to insert the new component within. 

7. Select Add, and choose the desired component to add. 

 

The selected option will be added to your layout and will display in 
the Layout Component tree. 

 

Note: The Spry components utilize a default style sheet created by 
Dreamweaver.  While customizing your design, there may be CSS properties 
(such as borders) that are applied to your Spry component but not displayed 
in CSS Sculptor. Entering your desired value in CSS Sculptor will override the 
default style sheet. 
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Type tab 

CSS Sculptor gives you the power you need to completely customize the font 
properties for standard paragraphs, headings and the various link states. 

1. In the layout tree, select the element you wish to modify. 

2. From the Text subtab, choose the font you wish to be used by the 
selected element. 

3. Specify any other type settings. 

4. Proceed through the interface by selecting additional layout 
components too specify text properties for. 

5. Select the h1 through Active subtabs to specify type properties for 
those specific styles. 

6. Once you have specified all the various text properties you require, 
move on to the Design tab. 

CSS Sculptor includes a pseudo-element that is frequently omitted from 
the typical series of link states, a:focus. The a:focus pseudo-element is 

typically applied when a link receives focus in a browser, either by being 
clicked or tabbed to. 

In the next section, you’ll learn how to add background images and borders 
to any layout component.  
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Design tab 

Background images and borders are integral to modern CSS layouts. CSS 
Sculptor makes it possible to add a background color and/or image, along 
with complete background properties to the body tag or any individual layout 
component. In addition, borders can be applied to surround any element or 
along any side. 

1. In the layout tree, select a component to apply a background image or 
border to. 

Note: Depending on the preset you selected, there may be a background 
color or background image already applied.  To avoid these settings 
overwriting anything you apply, you may want to remove these first. 

2. Specify a background color from the Color tab under Background. 

3. To apply a background image, choose the Image Source tab. 
Use the Image Repeat and Attachment and Image Position tabs to 
further specify the appearance of your background image. 

4. To apply a border, choose the Style of border from the menu list. 

5. Specify a width and color for your border. 

6. To customize the border for each side, choose the Top, Right, Bottom, 
or Left tabs. 

7. Click Apply to preview the changes.3 

8. Once all your changes are made, select the Print tab. 
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Print tab 

Modern browsers render the print style sheet when the Print Preview or Print 
command is issued. Many designers attempt to optimize their print style 
sheets for the more suitable print format, which typically expands the 
divisions to full width and reduces the color scheme to black and white. 
Additionally, certain areas – such as those which contain linked navigation – 
are hidden.  

CSS Sculptor allows you to set up such a style sheet quickly and easily. 

2. In the Global section, choose the Convert divs to page width 
checkbox, the Convert divs to black and white checkbox, and the 
Set margins and padding to zero checkbox.  

3. If print coloring is not required, select the Convert divs to black 
and white checkbox. 

4. If certain layout components should not be included in the printed 
version, select the component and choose Hide.  

Note: If you click the preview image, the page will display as shown 
in the Print tab preview pane and not as the screen style sheet is 
defined. To see the print style sheet in its intended usage, you’ll need 
to click Finish and preview the page in Dreamweaver using the Style 
Rendering toolbar or through your browser’s Print Preview command. 

With both screen and print styles defined, it’s time to establish your output 
options. 
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Output 

The final tab of CSS Sculptor gives you control over the page that is created. 
Options include the ability to set a doctype for the HTML page, determine the 
amount of placeholder content, and include or omit CSS comments.  

1. To set the amount of placeholder content to include in your generated 
layout, choose one of the options from the Placeholder list: 

• Full – Includes full lorem ipsum style placeholder text as displayed 
in the CSS Sculptor previews. 

• Minimal – Applies one sentence for each div. For example, 
“Content for header div goes here.” 

• None – Removes all placeholder content. 

2. If you’d like to remove comments from your CSS code, deselect the 
Include CSS comments checkbox. 

3. In the Page Generation section, choose your doctype from the Doctype 
list. The default is XHTML 1.0 Strict. 
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Managing colors 

CSS Sculptor 3 includes the Manage Colors interface, where you can change 
the entire color scheme for your site with only a few clicks. 

This interface is provided to quickly change the colors that are currently 
being used with new selections.  When changed, all elements in your CSS 
that use that color will be updated. 

Note: If you wish to only change the color for a specific element, you should 
use the Customize CSS interface. 

1. From the Quick Insert panel, choose the Manage Colors option. 

Choose Colors 

All the colors currently included in your design are listed here and grouped by 
the component that uses that color. 

2. Choose Move Up or Move down move the color to a different group of 
components. 
Refer to the Preview to see how the changes affect your design. 
 

 

3. Using the color swatch/color picker, change the color for the 
component groups. 
Using the color picker, you can select any color that displays on the 
Dreamweaver and CSS Sculptor interfaces. 
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Importing Colors 

To gain access to certain colors that you may like on a website or an image, 
the Color Importing feature has been included. 

4. Choose the Color Importer tab. 

5. Select the browse button to choose an image file to import or enter 
the URL to a webpage. 

6. Choose Apply. 

7. Using the color pickers, sample any color you wish to use from the 
import. 

Color Suggestions 

The Color Suggestions feature is provided to give you access to a number of 
color options that may help you achieve the look and feel you desire. 

8. Select a base color from the available color picker/color swatch. 

9. From the menu list, choose the type of suggestions you wish to view. 

10. Using the color pickers, sample any color you wish to use from 
these recommendations. 

11. Once you have finished modifying your colors, click Finish. 

After clicking Finish you will return to the Quick Insert interface. 
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